_je namenjen radu sa podacima organozovanih u vidu [TABELA.

Osnovna namena Excela je numericka obrada podataka na ureden nacin putem

formiranja tabela, primenom funkcija i formula koje omoguéavaju da izraCunavanjem
dodemo do rezultata.

Program se startuje komandom :

Mogucénosti programa ogledaju se u slede¢em:

enumericka obrada podataka, tabelarna izraCunavanja, izrada predracuna,
matematicka, statisticka, graficka i druga analiza rezultata,

eizrada spiskova, Sema i drugih dokumenata potrebnih u svakodnevnoj organizaciji
podataka,

e graficko prikazivanje podataka primenom velikog broja razlicitih dijagrama,

e koriscenje eksternih podataka, mogucnost razmene podataka sa drugim programima,

¢ upotreba slika i grafickih modela.

1.1. Elementi radnog prozora Excela

e Na vrhu Excel prozora nalazi se dugme Office Batton (otvara funkcije za rad sa
dokumentom: New, Save, Print, ...Close),

e paleta alatki Quick Access Toolbar,

e traka za naslov — naslovna linija i dugmad za zatvaranje programa, minimalnu i
maksimalnu veli¢inu prozora.

e linija osnovnog menija (Home, Insert, Page Layout, Formulas, Data, Review i
View),

e palete sa alatima grupisanim po funkcijama koje su predstavljene ikonama.



e Ispod toga je oznaka za ime Celije i polje za formule.
e U dnu prozora nalazi se oznaka statusa, radni listovi, pomeranje listova, insert
dugme,

e kliza€ po horizontali i vertikali, prikaz strane, kontrola uvecanja.

Radni prozor Excela:
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J _ - je linija na kojoj se (osim naziva programa Excsel) nalazi i ime
radne sveske Bookl. To ime se kasnije zamenjuje, posle komande Save As,

imenom koje smo dali dokumentu koji radimo i ostaje trajno.

J _ — sastoji se iz slededih kratica (opcija):

Home Insert Pagelayout References Mailings Review View

Pritiskom na svako dugme pojavice se linija - paleta sa alatima. (pogledati svaku opciju

menija).



1.2. PodeSavanje Excela (Excel Options)

Pritiskom na dugme Office u gornjem levom uglu otvaraju se funkcije za rad sa

dokumentom, odnosno funkcije za podeSavanje Excela. Izborom dugmeta

ExcelOptions pokrecemo grupu funkcija za podeSavanje Excela. l1zabrane opcije vazice

svaki put kada pokrenemo program, sve dok ih ne promenimo.

U grupi Popular u delu When creating new workbooks moze se podesiti font, velicina

fonta, broj listova (Sheets) u okviru radne sveske (workbook), izbor jezika. lzbor jezika
se vrsi tako Sto se izabere jezik u levom prozoru misem, a zatim se pritisne na dugme
Add cime ce se naziv jezika pojaviti u desnom prozoru. Na kraju se izbor potvrdi

pritiskom na dugme OK u donjem desnom delu prozora.

i 5
Excel Options I. ? —Ehl

Popular ) . .

D 3 Change the most popular options in Excel.

Farmulas

Proofing Top options for working with Excel

Save V| Show Mini Toolbar on selection (i

| Enable Live Preview (i
Advanced
Show Develaper tab in the Ribbon G

Customize Color scheme: | Blue EI

Add-Ins ScreenTip style: | Show feature descriptions in ScreenTips E|

Trust Center Create lists for use in sorts and fill sequences: | Edit Custam Lists...

Resources

When creating new workbooks

Use this font: Body Font El
Font size: 11 EI

Default view for new sheets: | Normal View E|

Include this many sheets: 3 s

Personalize your copy of Microsoft Office

User name: |Slobodan

Choose the languages you want to use with Microsoft Office: Language Settings...




U grupi Save u delu Save workbooks mozete izabrati da se vase tabele ¢uvaju u formatu

Excel 97-2003 Workbooks, a ne u originalnom formatu za Excel 2007, zbog ranijih zapisa
u Excel 2003 ili starijim verzijama. Takode, moZete promeniti lokaciju foldera gde ce

Excel smestati datoteke svaki put kada zadate komandu Save.
’ExceI\Dptions l 2 &r

Popular :

P H Customize how workbooks are saved.
Formulas
Proofing Save workbooks
Save Save files in this format: Excel Workbook IZ|
Advanced Save AutoRecover information every |10 = minutes
Customize AutoRecover file location: |ChUsers\SlobodantAppData\Roaming'Microsoft'\Excel,

Default file location: ChUsers\Slobodanm\Documents

Add-Ins
Trust Center AutoRecover exceptions for: [IT Bookl EI
Resources [7] Disable AutoRecover for this workbook only

Offline editing options for document management server files

Save checked-out files to:
@ The server drafts location on this computer

) The web server
Server drafts location: | Ch\Users\Slobodan\DocumentsiSharePoint Drafts',

Preserve visual appearance of the workbook

Choose what colors will be seen in previous versions of Excel:(i LColors...

U grupi Customize mogu se odabrati funkcije koje najvise koristite i koje ¢e se pojaviti

u paleti alatki Quick Access, u gornjem levom uglu. Izbor se vrsi pritiskom na funkciju u
levom prozoru, a zatim na dugme Add, posle cega se funkcija pojavljuje u desnom
prozoru. Funkcija se briSe pritiskom na funkciju u desnom prozoru, a zatim na dugme

Remove, posle cega ce ikona funkcije biti izbrisana iz palete alatki Quick Access.
Excel Options T | e S—

Popular

% Customize the Quick Access Toolbar.

Formulas

Choose commands from: (i Customize Quick Access Toolbar:
Proofing
Popular Commanads EI For all documents (default) EI
Save
Advanced =5eparators Choose commands from =l save
»
| — Calculate Now In addition to using this dialog ¥} Undo
Customize Calculate Sheet box, you can also add any item to ™ Redo >
the uick Access Toolbar by
Add-Ins Create Chart Q )

Custam Sort... right-clicking it inlthle Ribbon.

Trust Center Datasheet Formatting
Delete Cells...

Drelete Sheet Columns
Drelete Sheet Rows
E-mail

Insert Cells...
Insert Hyperlink
Insert Picture from File
Insert PivotTable
Insert Sheet Columns
Insert Sheet Rows
Mews

Resources
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Paste Special...
Print Preview
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1.3. Palete s alatima

Sadrzaj paleta s alatkama mozemo videti ako pritisnemo dugme u paleti sa komandama

(Home, Insert, Page Layout, Formulas, Data, Review i View).

Svaka opcija menija otvara svoju paletu sa alatima. Palete se ukljucuju, odnosno

iskljucuju komandom:

View > Show/Hide > izbor

Sadrzaj svake palete moze se menjati, Sto zavisi od potrebe korisnika.
Ako se prede strelicom miSa na odredenu alatku i zadrZi kratko vreme, program ce dati
znacenje te alatke.
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1.4. Linija za formule

Linija za formule se sastoji iz dva dela: [Name Box — u njemu se vidi polozaj aktivnog

polja, Formula Bar — aktivira se znakom jednakosti cime se ukljucuje opcija za pisanje

formula u suprotnom se u polju moze videti sadrzaj selektovanog polja iz radnog lista.
Kad u aktivno polje unesemo = formulu pisemo ili preko oznaka polja ili selektovanjem

polja kao i kucanjem operatora (+, -. *, /).




2.1 Radni list

_ je osnovni prostor u kome se radi. Sastoji se od _

Ciji je polozaj odreden oznakama kolona (A-Z i AA-IV — ima ih 256) i redova (brojevi od

1-65536) tako da polje u koloni A na rednom broji 10 ima oznaku A10. Referenca celije

kolone A i celije 1 je Al. upisana je u polju Name Box koja se nalazi neposredno iznad

radnog lista na levoj strani. Radna sveska se sastoj od radnih listova Sheetl, Sheet2,

Shett3,... Izbor lista vrSi se klikom misa na jezicak sa imenom radnog lista u donjem

levom uglu prozora programa. Odabrani radni list je tada AKTIVAN (sheetl). -
- zadaje se komandom

Office Batton > Excel Options > Popular

_. Ako Zelimo da taj naziv promenimo u neko ime koje nas na

nesto asocira pritisnemo na polje, zatim na krajnje levo polje iznad tabele i tu napiSemo
naziv.
Ukoliko zelimo da vidimo sva imenovana polja pritisnemo na strelicu pored polja u

koje smo unosili nazive, izaberemo naziv polja i ono se automatski oznaci.

Drugi nacin je izborom Formulas/Defined Names/Define Name i unesemo naziv celijel.

_. Za brisanje imena celije koristimo

Formulas/Defined Names/Name Manager| i izaberemo naziv celije i pritisnemo na

Delete.



2.2 Radna sveska

Vise radnih listova ¢ine radnu svesku (Workbook).

Radna sveska je u osnovi sastavljena iz tri radna lista (Sheetl, Sheet2 i Sheet3) koji se
generisu prilikom pokretanja Excel-a. Medutim, tokom rada radna sveska moze dobiti
neogranicen broj radnih listova. Radne listove biramo pritiskom na naziv radnog lista. U

jednom trenutku mozemo otvoriti vise radnih sveski.

2.3 Promena imena radnog lista

Nazive koji su dodeljeni svakom listu mozemo promeniti tako Sto ga selektujemo, posle
Cega se aktivira neka od sledecih procedura:
¢ dva puta pritisnemo na naziv lista, 3

e pritisnemo desnim tasterom misa na jezicak izabranog radnog lista i na otvorenom

kontekstnom meniju izaberemo Rename.

Na jezicku izabranog radnog lista upiSemo novo ime, a zatim pritisnemo levim tasterom

bilo gde na radnom listu. Na jezicku uo¢avamo novo ime radnog lista.

2.4 Promena redosleda radnih listova

Ukoliko raspored radnih listova ne odgovara mozemo ga menjati tako Sto pritisnemo
na list koji pomeramo, drzimo taster i kad dodjemo na zZeljeno mesto pustamo taster.
Mala strelica koja se pri tom javlja ukazuje na mesto gde ce biti smesten list koji

pomeramo.




2.5 Premestanje radnog lista s kopiranjem

Selektujemo radni list koji Zelimo da umnozimo (naziv), drZimo pritisnut levi taster misa
i taster <Ctrl>. Na malom listu koga drZi strelica misa pojavljuje se znak +. Kad
strelicom miSa dodemo na mesto gde Zelimo da smestimo umnozeni radni list,
otpustamo taster miSa i taster <Ctrl>. Na izabranom mestu se pojavljuje jezicak s

nazivom kopiranog radnog lista i oznakom naziv (2).

2.6 Umetanje novih radnih listova

Pritiskom dugmeta [Insert Worksheet (Shift + F11) - novi list se pojavi levo od lista koji

smo izabrali. Ako ima viSe listova ne moraju se svi videti pa ih mozemo listati strelicom.

2.7 Brisanje radnih listova iz radne sveske

Izaberemo radni list koji Zelimo da obriSemo. Pritisnemo desnim tasterom i iz

kontekstnog menija izaberemo |Delete. Ukoliko se na listu koji briSemo nalaze podaci,

pre brisanja se pojavljuje upozorenje kojim se trazi potvrda brisanja.




Startovati program Excel

Podesiti da radna sveska ima 6 radnih listova

Aktivirati 5.list

Napraviti redosled u svesci Sheet2, Sheet4, Sheetl, Sheet3, Sheet5, Sheet6
Listovima Sheetl i Sheet2 promeniti imena u Vezbal i Vezba2

Ispred lista 6 dodati novi list

Obrisati list 4

O N o U A~ W DNEPRE

Snimiti radnu svesku pod imenom Vezba 1 u folderu koji treba napraviti na

Desctopu pod nazivom M11.
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2. Office Batton >Excel Options > Include this mani sheets (podesiti na 6)

Excel Options — - M
Popular | s B . .
‘_g Change the most popular options in Excel.
Formulas
Proofing Top options for working with Excel
Save Show Mini Toolbar on selection '
Enable Live Preview (i
Advanced
|:| Show Developer tab in the Ribbon '
Customize Color scheme: | Blue IZI
Add-Ins ScreenTip style: | Show feature descriptions in ScreenTips |Z|
Trust Center Create lists for use in sorts and fill sequences: | Edit Custom Lists...
Resources

When creating new workbooks

Use this font: Body Font El
Fant size: 11 El

Default view for new sheets: | Normal View E

Include this many sheets: ] <

Personalize your copy of Microsoft Office

3. Aktiviranje odredenog lista se vrsi izborom u dnu strane na Sheet5.

4. Promena redosleda radnih listova vrSi se tako Sto pritisnemo na list koji
pomeramo, drZzimo taster i kad dodjemo na zZeljeno mesto pustamo taster. Mala
strelica koja se pri tom javlja ukazuje na mesto gde c¢e biti smesten list koji

pomeramo.

21
25
26
27
28
29
30
31
M 4 b M| Sheet? | Sheet4 Sheetl  Sheet3 - SheetS - Sheeté %1
Ready

Promena imena radnog lista vrsi se
¢ dva puta pritisnemo na naziv lista,

e pritisnemo desnim tasterom misa na jezicak izabranog radnog lista i na otvorenom
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kontekstnom meniju izaberemo Rename. Na jezicku izabranog radnog lista upiSemo

novo ime, a zatim pritisnemo levim tasterom bilo gde na radnom listu.

23

24

25

M 4 b b | Veibad - Sheetd -~ Veibal  Sheet3  Sheet5 . Sheetd - ¥]
Ready

5. Pritiskom dugmeta [nsert Worksheet - novi list se pojavi levo od lista koji smo

izabrali.

Vefba2 - Sheet4 . Vefbal - Sheet3 ,Sheet5 . Sheets | Sheet7 - #1
|IHEE¢ TicrksheetEShﬁt+F11J|

6. lzaberemo radni list koji zelimo da obriSemo. Pritisnemo desnim tasterom i iz

kontekstnog menija izaberemo Delete. Ukoliko se na listu koji briSemo nalaze

podaci, pre brisanja se pojavljuje upozorenje kojim se trazi potvrda brisanja.

23
24
25
M 4k M| Veiba? -~ Vefbal  Sheet3 - Sheet5 | Sheet6 - Sheet7 %1
Ready

7. Office Batton >Save As > Vezba 1.
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